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BWSpec® Release Notes 

Version 4.15_22 – Date of Release: 09/10/2024 
This document provides release notes for BWSpec®, a data acquisition software for B&W Tek spectrometer, 
NIR and Raman system products. This document details the changes in version 4.15_22 over the previously 
officially released version of BWSpec 4.15_10. 
 
Update Instructions: 
 

• When updating directly from 4.15_8 or later: user can directly upgrade from the existing version by 
running the setup.exe file using Windows administrative privilege.  
• For installed BWSpec version earlier than 4.15_8: It is highly recommended to uninstall the current 
version before installing this version.  

 

Compatibility 
1. This version is aimed to support all the Raman systems and spectrometer modules supported in 4.15_3. 

Please see the release information below for details.  
2. Added compatibility for the following spectrometer models: BTC281N, BTC283N, BTC284N, and BTC286N. 

Enhancement and New Features 
# Classification Details 

1  [New] When instrument status is offline, performance validation records can be accessed. 
2  [New] Minimum integration times for the following models have been changed: BTC281N: 

200us, BTC283N: 20us, BTC284N: 200us, BTC286N: 30us; 
3  [UPDATE] For Raman Shift and Laser Wavelength calibrations, the useful range to determine 

optimal Integration Time is changed to 350 – 2000 cm-1. 
4  [UPDATE] In Performance, when generating a PVR, the spectral range is editable and will 

determine the useful range for auto-integration. 
5  [UPDATE] In Performance, each peak has its own variation Vs. Ref and variation Vs. Last limit 

which can be edited by the user (excluding the main peak). 
6  [UPDATE] In Performance, the three peaks for Photometric Precision are mandatorily selected. 
7  

[UPDATE] 
User must select a Ratio 3 File to enable Relative Intensity Correction in Batch 
Process / Re-Process regardless of file type. 

8 [UPDATE] The Chemometrics checkbox is removed from Experiment Setup and Batch Re-
Process. 
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Bug Fixes 
# Classification Details 

1  [FIX] Fixed the issue where a small screen would obscure the Spectrometer Control Panel 
without a scroll bar.  

2  [FIX] Fixed the bug where BWSpec would crash if Workspace was changed when all chart forms 
are closed.  

3  [FIX Fixed the bug where the Analytics tab did not appear when performing a Batch Re-process 
with Peak Monitor enabled.  

4  [FIX] Fixed the bug where using Timeline Load to Batch Re-process x number of spectra more 
than once causes x number of overwrite messages. 

5  [FIX] Fixed the bug that caused BWSpec to freeze when stopping a Continuous Scan. 
6  [FIX] Fixed the issue with the Temperature Set function for BTC283N preventing the temperature 

from being set correctly. 
7  [FIX] Fixed the bug where interlock status was not being read correctly. 
8  [FIX] Fixed the bug where stopping a scan while BWSpec was determining auto-integration time 

froze BWSpec.  
9  [FIX] Fixed the bug where disconnecting then reconnecting an i-Raman Plus-532 caused the laser 

control to disappear. 
10 [FIX] Fixed the bug in Timeline Load where a Batch Re-Process configuration with Relative 

Intensity Correction enabled will cause a fail message to appear for every loaded .TXTR file 

 
Known issues 

# Classification Details 
1  [Known Issues]  Right-clicking on the microscope image and selecting Save Image does not save the image.  
2  [Known Issues]  Batch Process function is not compatible with data with two columns.  
3  [Known Issues]  DIY Raman system response might be slow when hardware settings are open and ratio files 

are being created  
4  [Known Issues] For i-Raman Plus, BWSpec might become non-responsive if the user unplugs the USB cable, 

then plug it back in immediately. Users need to restart the instrument  
5 [Known Issues]  When using a DIY setup if the common setting for “Close Laser After Data Scan” is 

unchecked, the laser may turn itself off after a few scans.  If that happens, turn the laser 
back on using the laser button, then it will not turn off on its own again. 

6 [Known Issues] Running Sol HT models BTC281N, BTC284N, BTC286N with External trigger enabled: The 
device requires an additional External Trigger event after pressing STOP scan button. The 
software will freeze until this External Trigger is received by the spectrometer, or the 
spectrometer power and USB is cycled.  

7 [Known Issues] When initializing a IPS USB laser, any scan taken prior to initialization will display the 
incorrect RamanShift in the software. In this case, clear all spectra before initializing the IPS 
laser.  

8 [Known Issues] Batch Process in the Spectral Function menu and Timeline Load in the File menu are not 
compatible. Using one after another causes the Spectrum List Panel and chart to clear. It is 
recommended to only use one function at a time.  
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Version 4.15_10 – Date of Release: 07/15/2023  
 
This document provides release notes for BWSpec®, a data acquisition software for B&W Tek spectrometer, 
NIR and Raman system products. This document details the changes in version 4.15_10 over the previously 
officially released version of BWSpec 4.15_8. 
 
Update Instructions: 
 

• When updating directly from 4.15_8: user can directly upgrade from the existing version by running the 
setup.exe file using Windows administrative privilege.  

• For installed BWSpec version earlier than 4.15_8: It is highly recommended to uninstall the current 
version before installing this version. 

 
Compatibility  
This version is aimed to support all the Raman systems and spectrometer modules supported in 4.15_3. Please see 
the release information below for details.  

 
Enhancement and New Features  
 

# Classification Details 
1 [UPDATE] The spectrum chart display is set to show anti-aliased line style by default.  

2 [UPDATE] States of Reference and Linearity Correction are removed from the bottom status 
bar in Raman workspace as they are not relevant in Raman devices.  

3 [UPDATE] 
When “Automatically Take Dark After Data Scan” is enabled, the Acquire Dark 
button is disabled so that the integration time of the dark scan will always be the 
same as the regular scan.  

4 [UPDATE] Closing the Workspace window that appears when opening BWSpec will close 
BWSpec. 

5 [New] 
A Stop button has been added for Raman Shift calibration so new A Coefficients 
are not generated if the user decides to cancel the calibration. User still need to 
wait until the scan finishes, but the new A coefficients won’t apply.  

6 [UPDATE] When Auto Time is enabled, the manual integration time button is disabled 
automatically.  

7 [New] User can use the shortcut Ctrl+W to switch between workspaces when the Main 
Form has focus. 

8 [UPDATE] 
Integration Time warning message pop-ups have been removed. Now, if an 
invalid Integration Time is entered by a user, the warning message will appear in 
the bottom status bar. 

9 [New] The PVR files newly created from the latest BWSpec and Vision (version 4.1.1.362 
or higher) are now compatible with either software.  
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Bug Fixes 
 

# Classification Details 

1 [FIX] Fixed the bug of the laser power controls disappearing when an i-Raman is 
disconnected and reconnected;  

2 [FIX] Fixed the bug in Peak Analysis that if a peak was deleted, it could not be added 
back; 

3 [FIX Fixed the bug where deleting a peak from the Peak Analysis table did not delete 
the Peak Area Fill displayed in the chart; 

4 [FIX] Fixed the issue of the PVR file name changing when an existing PVR file is loaded 
and then viewed in the Performance Test module; 

5 [FIX] Fixed the bug where the laser controls in Hardware Setup would be re-enabled 
after a Timeline Experiment is set; 

6 [FIX] Fixed the bug in Raman workspace where automatically taken dark scans were 
not overwriting the existing dark scan; 

7 [FIX] Fixed the bug that BWSpec will crash if the user presses Update Settings in the 
Wavelength Calibration module when there isn’t a spectrum loaded.  

8 [FIX] Fixed the bug that deleting one row from the Peak Analysis table would delete 
two rows; 

9 [FIX] 
Fixed the bug where a scan would be acquired using Auto Time even though an 
Experiment with a fixed integration time was enabled. Now when the experiment 
setup with a fixed integration time is enabled, auto time won’t be used.  

10 [FIX] Fixed the bug that microsecond unit for integration time setting is not shown in 
Raman workspace when switching workspace from BWSpec to Raman; 

 
Known issues 
 

# Classification Details 

1 [Known Issues] Right-clicking on the microscope image and selecting Save Image does not save 
the image.  

2 [Known Issues] Batch Process function is not compatible with data with two columns. 

3 [Known Issues] DIY Raman system response might be slow when hardware settings are open and 
ratio files are being created 

4 [Known Issues] 
For i-Raman Plus, BWSpec might become non-responsive if the user unplugs the 
USB cable, then plug it back in immediately. Users need to restart the instrument 
then plug in the USB cable.  
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Version 4.15_8 – Date of Release: 3/31/2023 
This document provides release notes for BWSpec®, a data acquisition software for B&W Tek spectrometer, 
NIR and Raman system products. This document details the changes in version 4.15_8 over the previous 
officially released version of BWSpec 4.15_3. 
 
Important Notice: it is highly recommended to follow these steps to update your BWSpec to the latest 
version:  
1. Backup your Ratio3 files from the BWSpec folder, which is typically located at C:\BWTek\BWSpec\ratio\ 
2. Record settings of any Experiment Setup configurations currently in routine use 
3. Uninstall the existing BWSpec  
4. Completely delete the BWSpec folder, typically located at C:\BWTek\BWSpec 
5. Install the latest version of BWSpec 
6. Reconfigure the probe setup with the Ratio3 file, and Experiment Setup for routine use 
 
After update, user will need to reconfigure their Experiment Setup and Probe Setup configurations 
accordingly, as the previous Experiment Setup and Probe Setup settings might not work with the new 
BWSpec version.  

Compatibility 
 

This version is aimed to support all the Raman systems and spectrometer modules supported in 4.15_3. Please see 
the release information on page 4 for details.     

Enhancement and New Features 
 

# Classification Details 
1 [UPDATE] Updated the User Interface icons to generate smoother experience. 

2 [UPDATE] Updated the installation process so that USB drivers are automatically installed 
with Windows security certificates.  

3 [UPDATE] Updated the installation so that admin access check is automatically performed 
when double clicking setup.exe. 

4 [UPDATE] Improved the display and usage of the integration time box and time unit to 
avoid software conflicts during scan or when auto-integration time is selected. 

5 [UPDATE] Improved the software interface to avoid crashing when i-Raman Prime is first 
connected within 5 minutes. 

6 [UPDATE] Added Language Menu to support Chinese, Japanese, and English. 
 

Bug Fixes 
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# Classification Details 

1 [FIX] Fixed the bug that the software will crash if running in Korean Language Windows 
Environment 

2 [FIX] 
Fixed the bug that rounding format of the Dark Subtracted column in txtr files is 
sometimes different. Now all the numbers are rounded to 4 digits after 
decimal. 

3 [FIX] 
Fixed the bug that when PVR File is selected while the name is deleted, running 
Performance Validation will cause software crash; now the user cannot leave 
the pvr file name empty/deleted. 

4 [FIX] Fixed the bug that saving a PVR file and Raman Shift Calibration in 32-bit 
installation will cause unhandled exception; 

5 [FIX] Fixed the bug that Digital output 2 set to low for some OEM spectrometer 
versions might not work, including but not limited to BTC655, BTC115. 

6 [FIX] Fixed the bug that operations on reading/writing on EEPROM of RS232 
spectrometers may cause software crash;  

7 [FIX] Fixed the bug that scans with averaging take much longer time than expected for 
RS232 spectrometers.  

 
 

Known Issues 
 

# Classification Details 
1 [Known Issues] Batch Process function is not compatible with data with two columns. 

2 [Known Issues] DIY Raman system response might be slow when hardware settings are open and 
ratio files are being created 

3 [Known Issues] 
For i-Raman series, BWSpec might become non-responsive if the user unplugs 
the USB cable, then plug it back in immediately. Users need to restart the 
instrument then plug in the USB cable.  
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Version 4.15_3 – Date of Release: 11/16/2022 
This document provides release notes for BWSpec®, a data acquisition software for B&W Tek spectrometer, 
NIR and Raman system products. This document details the changes in version 4.15_3 over the previous 
officially released version of BWSpec 4.11_1. 
 
Important Notice: it is highly recommended to follow these steps to update your BWSpec to the latest 
version:  
1. Uninstall the existing BWSpec 
2. Backup your Ratio3 files from the BWSpec folder, which is typically located at C:\BWTek\BWSpec\ratio\ 
3. Completely delete the BWSpec folder, typically located at C:\BWTek\BWSpec 
4. Install the latest version of BWSpec 
 
After update, user will need to reconfigure their experimental setup and probe setup accordingly, as the 
previous experimental setup and probe setup might not work with the new BWSpec version.  

Compatibility 
 

This version is aimed to support these following Raman system products:  

Product Name Model Number 
i-Raman Plus BWS465 series 
i-Raman Pro BWS475-xxxS and BWS475-xxxH series 
i-Raman Prime BWS475-xxxx-HT series 
i-Raman EX BWS485II, BWS485III 
PTRam BWS476-785H 
STRam BWS475-785H-ST 
STRam-1064 BWS475-1064-ST 
QTRam BWS475-785H-CU 
Video microscope BAC151C series 

    

And these following spectrometer modules:  

 

Product name SP model 
Quest BRC112P-x 
Quest BRC113P-x 

Exemplar BRC115P-x 
BRC1K-P BRC1K-P 

i-trometer BRC642E 
Cypher BRC741E-512 
Cypher BRC741E-1024 
BRC813 BRC813 
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Glacier-X BTC112x 
Glacier-T BTC162x 

Sol1.7 BTC261P 
Sol2.2 BTC262A 
Sol2.6 BTC263E 
Sol HT BTC281N 
Sol HT BTC282N 
Sol HT BTC283N 
Sol HT BTC284N 
Sol HT BTC284P 

Exemplar Plus LS BTC645N 
Exemplar Plus BTC655N 

Exemplar T BTC665N 
Exemplar HT BTC667N 
Exemplar Pro BTC675N 

 

Enhancement and New Features 
 

# Classification Details 
1 [UPDATE] Updated installation EULA, logo and company address 

2 [UPDATE] 
File: “Save All data into a BIN file” and “Set Save Data Format” is now removed 
and replaced with function “Set Auto Save Data File”. User can use the new 
function to set data saving path and format, automatically or manually.  

3 [UPDATE] Removed legacy data format BWRam across the board 

4 [New] Added support to 2 column data format (simple txt, simple csv, and raw csv) 
generated from B&W Tek handheld device and software 

5 [UPDATE] Set txtr file as default at all data saving options; 

6 [UPDATE] File->Export Data, Spectral Units now is changed to radio box; - only one spectral 
unit can be selected to avoid conflict 

7 [UPDATE] Removed duplicate warnings when two data files with the same name but 
different format are loaded to the software 

8 [UPDATE] View -> Display Scales: removed the table of Raman Excitation Laser Wavelength 
9 [UPDATE] Acquire menu is renamed to Acquisition 

10 [New] Spectra Function: added Enable/Disable Linearity correction, now available for 
individual scan for users who would like to acquire y-axis linearity corrected data.  

11 [New] Spectral Function: added Enable/Disable Irradiance Calibration. 
12 [New] Spectral Function: added Enable/Disable Reference Material Correction 

13 [New] Spectral Function: added Enable/Disable Relative Intensity Correction. User can 
select the ratio file and enable relative intensity correction at all time.  
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14 [New] 
Spectral Function -> Peak analysis: Added checkbox of adding a peak manually 
and capability to remove a peak manually by right-clicking the peak record in the 
peak analysis table.  

15 [UPDATE] Spectral Function: Baseline removal menu is now always visible 

16 [New] Tools: Relative Intensity Correction: added standard material SRM2242a for 
532nm Raman system relative intensity correction  

17 [New] Tools: added Laser Wavelength Calibration to offer capability for user to 
manually adjust or auto calibrate laser excitation wavelength 

18 [UPDATE] Tools: Redesigned Performance Validation menu to better align with USP chapter 
<858> and EP 2.2.48 (see user manual for details) 

19 [UPDATE] 
Tools: Redesigned Raman Shift Calibration menu to better align with USP chapter 
<858> and EP 2.2.48 (see user manual for details) User can now save the new 
settings to local PC only, instead of saving them to EEPROM.  

20 [UPDATE] Plug-in: Removed legacy plug-ins including BAC151A Camera, BAC151B Camera 
21 [UPDATE] Setup: Spectrometer Info is now moved under Hardware Setup 

22 [New] Setup -> Flash Access: added a function “Download All Data” to download all 
instrument EEPROM data for service analysis.  

23 [New] Setup->Hardware Setup-> Spectrometer info, added Hardware code and System 
Hardware Code, and button Write EEPROM 

24 [New] Setup->Hardware Setup->Common Setting: added checkbox of Enable 
Gain/Offset Adjust for specific InGaAs spectrometers 

25 [UPDATE] Setup->Hardware Setup: removed legacy functions including Common Setting -> 
Write EEPROM, Aux Port -> Multi-Purpose Pin section, Color Setup.  

26 [New] Setup->Hardware Setup: added new table Laser Setup to support multiple laser 
system 

27 [New] Setup -> Experiment Setup: Added checkbox in Experiment to enable/disable 
Experiment, and added function to clear config file 

28 [UPDATE] About: moved to the main menu bar 

29 [New] Toolbar: added Auto-saving button to turn on/off data auto-saving feature and 
the full function is configured under File menu->Set Auto Save Data File 

30 [New] Status bar: added warning message while waiting for external trigger signal to 
start an acquisition 

31 [UPDATE] Status bar: removed Dark compensate status 
32 [New] Status bar: added interlock information 
33 [UPDATE] Slightly modified how ratio data is displayed in the txtr format 

34 [New] 
Added option of “Change Laser Excitation Wavelength” when right-click spectrum 
name on Spectrum List Panel. Support spectral file format that contains meta 
data such as txtr. Do not support simple txt, spc, csv format.  

 

Bug Fixes 
 

# Classification Details 
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1 [FIX] Fixed the bug that txtr data file ratio3 and dark subtracted data might not be 
saved properly due to rounding issues.  

2 [FIX] Fixed the bug in File->File Convert that if the to-be-generated TXTR filename 
already exists in target folder, software will crash; 

3 [FIX] Fixed the bug that loaded SPC file cannot be displayed correctly if this data was 
previously saved in 0.1 or 0.2 interval; 

4 [FIX] Fixed the bug that if the selected spectrum filename or Its directory contains 
space, exporting to Excel( File->Excel) will cause error; 

5 [FIX] 
Fixed the bug that if both External trigger and Auto time are enabled, when press 
Scan button, it will start to automatically set integration time even before press 
the trigger; 

6 [FIX] Fixed the bug that any editing in Timeline Load and Batch Process will cause 
software crash; 

7 [FIX] Fixed the bug that Do/Undo buttons are missing in Spectral Function->Batch 
Process… 

8 [FIX] Fixed the bug that using timeline with i-Raman Plus with external trigger might 
cause software crash 

9 [FIX] 

Fixed the bug that In Raman Workspace, with experiment enabled, after both the 
signal and the dark scans are completed, if change both the integration time and 
the Relative Intensity Correction setting and then acquire new spectrum using 
overlay, software assumes the change is applied to previous completed spectrum 
and forces you to acquire new dark.  

10 [FIX] 
Fixed the bug that clicking Export (to Excel) in Peak Analysis will cause software 
crash. 

11 [FIX] 
Fixed the bug that when using Experiment Timeline, the saved spc file might not 
have the correct integration time unit.  
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Version 4.11_1 - Date of Release: 03/18/2019  
 
This document provides release notes for BWSpec®, a data acquisition and analysis software for B&W Tek 
spectrometer, NIR and Raman system products. These release notes detail the changes in version 4.11_1 over 
the previously released version of BWSpec 4.11. 
**A listing of software updates for BWSpec 4.10 and for this version, BWSpec 4.11_1 are included in the 
BWSpec User Manual**  
 
CAUTION: 
Refer to Doc# 290020239 BWSpec Software and Hardware Installation Guide and follow the instructions to 
perform software and driver installation or updates. 

Release History Table 
Release Date 6/19/2017 8/31/2017 11/29/2018 3/18/2019 

Version 4.10 4.10_4 4.11 4.11_1 

Enhancement and New Features 

General Functionality 
# Classification Details 
1 [NEW] Add BAC151C Support 
2 [UPDATE] New End User Licensing Agreement (accepted at BWSpec Installation) 
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Version 4.11 - Date of release: 11/29/2018  

Enhancement and New Features 

General Functionality 
# Classification Details 

1 [FIX] 
Pulse Output function now properly compares the current set Integration Time to 
the Total Pulse Train Time. Error message will appear if Pulse Train is longer than 
Integration Time. 

2 [FIX] *.txt to *.txtr file conversion tool has been improved to properly load files with 
short filenames. 

3 [FIX] A bug causing BAC151A-A cameras to not appear in BWSpec is now resolved. 

4 [FIX] Excel Export of Analytical Data will rename the exported file to “Excel_Analytical” 
rather than use the selected spectra name to avoid confusion. 

5 [FIX] Software Set TE Cooled Spectrometers running on computers with non-U.S. 
number format setting will now properly set and read TE Cooler Temperatures. 

6 [FIX] An issue related to an incorrect maximum integration time setting for Sol 1.7-256 
spectrometers has been fixed 

7 [FIX]  An issue of unexpected software error with i-Raman EX systems following 
creation of a probe setup has been fixed.   

 

BAC151x LED Illumination and Shutter Control 
# Classification Details 

8 [UPDATE] 

Changes in LED Illumination control behavior:  
1. To enable LED Illumination control, BAC151x Plug-in must be enabled in 

the Plug-in Manager.  
2. If LED is turned on before taking any scan, it will turn off automatically 

during the scan, then back on after the scan. If the LED is manually 
turned off using BWSpec Checkbox, it will stay off until it is manually 
turned on. 

9 [KNOWN ISSUE] 

It is not possible to run spectrometers with built-in shutter and BAC151x camera 
concurrently. To enable shutter control for select spectrometers with built-in 
shutter, the BAC151x Plug-in must be disabled in the Plug-in Manager, and vice 
versa. 

 

Experiment Setup 
# Classification Details 

1 [NEW] 

Sample Information Form now added to Experiment Setup. Detailed information 
about a run can now be saved in *.txtr file type, and information can be read 
back by checking the Spectrum Information Panel.  
Information that can be saved is: Run Name; Product Name; Batch#; Lot#; 
Supplier; Notes.  
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2 [NEW] 
Manual Peak Area Calculation is now added to Experiment Setup > Peak Monitor 
Setup. This allows user to manually select the “Zero” points, and area calculation 
starting and ending points. 

3 [FIX] 
Fixed an issue where Experiment/Batch Process configuration files were not 
saving properly. Configuration files now save the current workspace setting 
(BWSpec or Raman) and they cannot be loaded in any different workspace. 

4 [FIX] When Chinese language and Raman Workspace is set, the Peak Monitoring 
Source is now locked to “Dark Subtracted (Processed)” instead of “Raw Data” 
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Version 4.10_04 - Date of release: 08/31/2017  
This document provides release notes for BWSpec®, Spectrometer Data Acquisition and Analysis Software 
Program, version 4.10_4 over the previously released version of BWSpec 4.10. 

Bug Fixes 

General 
1. LED Illumination control fixed for models: BWS415 (i-Raman), BWS465 (i-Raman Plus), BWS475 (i-Raman 

Pro), BWS485 (i-Raman EX). LED Illumination now always turns off during data and Dark scans, and reverts 
back to the state before the scan.  
LED Illumination manual control checkbox now appears when BAC151X plugin is enabled in Raman 
Workspace. If LED Illumination is manually turned off, it will stay off until manually turned back on.  

2. Decimal value is not allowed in Integration Time input box anymore to resolve software freeze. 
3. Various editorial changes, including updated BWTek logo and certain terminology. 

Product Model BTR115 
1. Laser now does not turn on and off automatically for each scan during Timeline process. 
2. Removed the configuration checkbox for “Open Laser on Data Scan” and “Close Laser After Data Scan” in 

Hardware Setup > Common. 

Product Model BTC261P 
1. Fixed the issue where x-axis scale range always reverts to displaying full range instead of the factory set 

range. 
2. Integration Time Unit can no longer set to microsecond (µs) in Raman Workspace.  

Enhancement and New Feature  
1. Command Center (a feature for BWS496 (TacticID)) now allows for custom Library spectra download in 

addition to No Match spectra.  
2. Japanese version is now available (license required). 

Known Issues 
1. Timeline chart time axis is relative to the time of first spectrum acquisition, does not report real time.  
2. Spectrum cannot be saved with a file name already in use by another one listed in Spectrum List Panel.  
3. In Spectrum List Panel if a spectrum name is expanded to show the details and it is at the top of the field, 

clicking the "-" to collapse the field can uncheck all spectra.  
4. Colorimetry Color Space v’ value calculation is incorrect. 
5. When using Pulse Output (a Multi-Purpose Pin function under Setup > Hardware Setup > AuxPort), the total 

pulse duration value in microsecond (µs) is incorrectly compared to the input value of Integration Time. It 
does not consider the set Integration Time unit, causing an error message, and inability to use the function. 

6. PC may experience unexpected crash when using RS232 communication based spectrometers (ex: 
BRC113P, BTC113P…etc.) under certain operations forcing PC restart. 
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